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Overview
AudioFinder is a professional music application and unique in the world of music 
software, it has its own niche.    AudioFinder lets you look at what is already on your 
system's hard disks in new ways so that you will find sounds that you never knew you 
had.    AudioFinder is the fastest way to find audio files in the history of the planet -- 
really we mean it.

Ask yourself what good is it to have thousands of sounds on your computer if you don't 
know what they sound like or where to find them?    How does one tame a hard drive full
of sounds and make them appear when called?    Those are the questions that brought 
AudioFinder into being.    There are a zillion different ways to use AudioFinder even 
though it may appear very simple, it is actually very smart.    It does the monotonous 
tasks and scanning for sounds while you do the fun and creative stuff.

AudioFinder was designed for digital musicians to gain control over their sample library. 
The idea behind AudioFinder is elegantly simple - provide a user interface that is 
optimized for browsing and auditioning audio sample files rapidly.    AudioFinder can be 
controlled exclusively from the keyboard or by the mouse.    By using the up and down 
arrows the user can quickly scan hundreds of audio files.    When the user finds an 
audio file that they would like to use in a project they can either copy the file or refer 
(make an alias) the file to the favorites directory.    When the user has found all the 
sounds they plan to use in a music project they simply go to the favorites directory and 
start work using their music program of choice.    Double clicking on a file opens it in the 
preferred audio program as configured in the preferences.

Another problem that AudioFinder solves is the management of drum loop files.    Often 
a drum loop will not have the BPM in the file name therefore making it difficult to find the
right match when searching for a loop.      AudioFinder can guess the BPM or the user 
can utilize the BPM Tap Pad to tap out the tempo.    Once the BPM is found AudioFinder
can rename the audio file to include the BPM.    This can be a great time saver when 
searching for drum loops that are close to the tempo of a music project.    Additionally 
DJ's can use AudioFinder's BPM Tap Pad to quickly find out the tempo of their favorite 
vinyl.



There are even more great features like the ability of AudioFinder to "Autopilot" and play
a list of audio files.    The idea here is to use AudioFinder in conjunction with your music 
creation tool of choice.    Launch your music program (IE, Ableton Live or Reason) and 
start your song playing.    Launch AudioFinder and navigate to a directory where your 
samples are.    Click the first sample file in the list and then click the "Auto" button.    Sit 
back and listen as AudioFinder "Autopilots" the list, when AudioFinder plays a sound 
that you want to use in your project click the "Copy to Favorites" button.    Then switch 
back to your music program and add the sound file.    AudioFinder transforms a simple 
directory into a sample CD.

Note: Currently AudioFinder supports the AIFF, AIFC, SD2, REX and WAV formats, the 
primary formats for all professional music software.    AudioFinder can even play what is 
inside of a REX file.

Message From The Author
I originally invented AudioFinder out of my own necessity.    I've have had the idea for 
this program for many years, and I expected that someone somewhere would have the 
same idea and write it for me.    It never materialized, so one day I sat down and instead
of working on music like normal, I thought I'd do a little research into how much work it 
would be to write.    The research took over my free time for a few months and 
AudioFinder was born.      I realized AudioFinder was too useful to keep to myself, 
although I thought about doing just that.    So I decided to share it with you.    I ask you to
purchase AudioFinder, if and only if it makes your music experience better.    When 
people purchase AudioFinder, I think to myself, I'd better update it for them and keep 
making it better.    

Thank you to all the early adopters and registered users! 

How to Use
Clicking on a sound automatically plays it.    Additionally use the arrow keys to navigate 
in all directions.    Use the space bar to play or stop a sound.    For a detailed list of 
keyboard short cuts see "Short Cuts" under the "Help" menu.

AudioFinder assumes that a loop is perfectly cut and uses the file's length among other 
things to guess the BPM.    Listen to the file, count the beats and select the number of 
beats via the popup menu.    This will yield a best guess at the tempo.    For instance, if 
you have a 4 on the floor kick drum loop that is 1 bar long select 4 beats from the popup
menu.    If the loop is 2 bars long, select 8 beats from the popup menu on so on.

To listen to the contents of a list automatically click the "Auto" button, this will begin 



playback from the currently selected track until the last track is reached.    The Mac 
essentially then Autopilots & plays all of your sounds while you sit back and listen.    This
is a great way to preview sounds and at anytime the sound can be aliased or copied to 
favorites without stopping playback.    Under the Options menu you can also turn on 
Shuffle play which will randomly play all sounds.

The favorites drawer is provided as a way to quickly view the files you've already 
decided to use.    If you want to play the sounds in the favorites drawer you must switch 
to the browser.    You can however, double click to open a sound in your selected audio 
editor.

Comments may be entered for any sound and they are also visible with the Mac OS 
Finder's Get Info panel and vice versa.

Main Window

File Well:    Drag a folder or file into the file well to quickly move to the location.    Drag
the file from the file well to copy the selected file.
Auto:  Plays the contents of a directory starting from the selected song.    AudioFinder 
Autopilots & plays the directory for you.
Loop: Loop played the current file infinitely.    Try this with drum loops for instant 
grooves.    One could even perform with just this.
Play:    Plays the selected song.
Select Beats:    Used in detecting the BPM
Tap:  Brings up the BPM Tap Pad
Rename With BPM:  Renames the current sound file to include the BPM settings.
BPM field:    The BPM from either the Tap Pad or BPM detector, this field can be 
edited manually as well.
Copy:    Copies the selected sound file to the favorites directory.
Alias:    Makes an alias    of the selected sound file in the favorites directory.
Trash:    Moves the selected sound file to the Trash.    The sound can be retrieved from
the Mac OS X system Trash can if needed.

The Browser Tab
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(AudioFinder in Browser Mode)

The Browser Tab is manual way to navigate the folders and files, it is similar to column 
view in Mac OS X Finder.    When you switch to the Seeker Tab this is    point on disk 
where you are seeking from.    



The Seeker Tab
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(AudioFinder in Seeker Mode)

The Seeker Tab is a birds eye view of all the directories from the location currently 
selected in the Browser.    The more files the longer it will take to scan as AudioFinder 
recursively cruises through all the directories and looks for sound files.    AudioFinder 
scans for files in a background thread.    The status bar on the bottom will indicate how 
far along AudioFinder is.    In general it is good to navigate in the Browser Tab to the 
directory that is nearest to where your sounds are kept and then select the Seeker Tab.  
This will be much faster.    However, it is also perfectly valid to navigate in the Browser 
Tab to the root of a volume and scan the entire hard disk, this will take sometime, but 
will yield a complete list of all sound files on your computer.    Once this is full scan is 
complete you can click the disk icon next to the find field and save the results into 
AudioFinder's long term memory.    Then you will not need to scan again and every 
sound on the system will always be instantly available in the Seeker each time you 
launch AudioFinder.    Note: if new sounds are added, moved, renamed or deleted 
outside of AudioFinder the saved long term memory will get out of sync.    This is 
harmless, and can be fixed by rescanning.

The Find field is a very powerful feature.    This enables you to find any sound based on 
the file name.    A list of useful keywords is already stored in the combo box and will 
auto-complete for you as you type.    For instance just type 'Lo' and 'Loop' will be filled in
automatically.    Finds happen instantly since all of the files are already in the list.    In the
screen shot above AudioFinder had thousands of files in the Seeker.    Every sound 
instantly at your fingertips,    There is nothing like this feature anywhere, if you are 
addicted to using samplers, this is a massive time saver.

Setup Seeker Long Term Memory With Every Sound On Your 
Computer

1.    Go to the Go menu and click "Root"
2.    Click the Seeker Tab and prepare to wait a while.    You won't have to wait next time.
3.    On the bottom of the tab the progress bar will indicate how far along AudioFinder is 
in scanning your system.
4.    When the scan is done click the disk icon.
5.    Go to the Option menu and click "AudioFinder Launches in Seeker Memory"

Once this process is complete each time you launch AudioFinder all your sounds will be
in the Seeker window and instantly findable.

Creating A Soundbank From The Files In The Seeker



AudioFinder can create and entire Soundbank of sounds based on the sounds visible in 
the Seeker.    For instance you may want to consolidate a bunch of similar sounds (IE. 
bass or snare) into one folder for use with a software sampler plug-in.    To do this first 
find the sounds in the Seeker and then go to the File menu and click "Create 
Soundbank.      A folder will be created with the name you entered in the save panel and 
all of the visible sounds in the Seeker will be copied to the new folder.    When the 
process is complete AudioFinder will beep.    NOTE:    If you have a huge number of files
or the files are very large you must have enough free disk space for the files to be 
copied.

BPM Tap Pad

Space bar: Hitting the space bar marks one beat.
Silent: Turns off the audio feedback kick drum sound.
Reset: Resets the average BPM.    This must be done before tapping on each file.

Playback Speed

Playback speed will either slow down or speed up the playback of the currently selected
sample.    If you wish to permanently alter the speed of the file go to the File menu and 
click "Write Playback Speed to Sound".    This will change the sample rate in the file's 
header.    Clever use of this simple feature opens up a world of creative possibilities.

Preferences:
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Favorites Folder: The location where AudioFinder copies or aliases files to.
Use Without Creating "AudioFinder Favorites" in Folder:    By default 
AudioFinder creates an "AudioFinder Favorites" folder in the specified favorites folder, 
this option bypasses this.    It is useful for when you want to copy files directly into a 3rd 
party music application project file.
Startup Folder: The directory AudioFinder displays when it is first run.
Audio Editor: The preferred program for editing or using audio files.    If left empty the
file will open in the program assigned by the OS.
Postfix Filenames With BPM: By default AudioFinder prefixes the BPM to the 
filename when renaming.    This option places the BPM at the end of the filename.
Use Decimal Precision For BPM: By default AudioFinder rounds off the BPM to 
the nearest whole number value.    This option uses decimal precision.
Browser Shows All Files: This option will set the browser to display all files 
instead of just audio files.



Options Menu:
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Seeker Uses Saved Scan Memory: This option is a huge time saver.    After 
AudioFinder has scanned an entire system or folder the results of the scan can be 
saved into AudioFinder's long term memory.    When this option is checked anytime the 
Seeker is used it bypasses scanning and uses the saved long term memory.    

AudioFinder Launches in Seeker Memory:    After a scan has been saved to 
long term memory AudioFinder can be set to open in the Seeker Tab when launched.    

Seeker Uses Slower Maximum Scan: Scanning a computer for sound files is a 
slow process because AudioFinder literally has to look at every file and determine if it is 
a usable sound or not.    In order to speed this up AudioFinder looks at just the file 
extensions for audio files.    This option tells AudioFinder to open every file and look 
inside the header to determine if it can be played.    It slows down the scanning 
processes, but will show files even if they have no file extension.

Find Also Searches in Paths: This option tells AudioFinder to include the actual 
description of the text in the pathname in a find.    For instance some files may have a 
non-useful name like "001.aif", but are in a folder called "/pads/001.aif".    AudioFinder 
will look at not only the filename, but the pathname when doing a find.

Shuffle Play in Autopilot:  Does what is says, plays sounds in random order.

Delay Between Sounds in Autopilot: Pauses between playing each sound, 
useful for short sounds.    When Autopiloting drum hits it is advisable to turn this on.

Rescan Now: Freshen up the scan memory, this will also turn of the Seeker Uses 
Saved Scan Memory if it is enabled.    This will switch you back to live scanning mode, 
so it makes sense to save the results of the scan so you can use memory mode again.

Cool Things To Do

Performance Mixing

AudioFinder can create new instances of itself and each instance can play a different 
sound.    The new instances are actually independent copies of AudioFinder and each 
needs to be Quit when you are done with it.    Try the following:



1. Pick a drum loop and click Loop and press Play.
2. Go to the File menu and click "New AudioFinder Instance"
3. In a moment a second copy of AudioFinder will appear in your dock.
4. Click the new copy of AudioFinder and select a pad or drone sound, click Loop and 
press Play.
5. Goto step 2 and repeat as many times as you like.

This is a great way to test how sounds are going to work together.    Don't forget to use 
the speed control to make the sounds fit together.

Using AudioFinder With 3rd Party Music Applications

AudioFinder does one job and it does it better than any other application.    AudioFinder 
finds your sounds.    Music sequencing programs like Ableton Live or Digital Performer 
are amazing tools for sequencing, but their file browsers are extremely limited.    Here is 
an easy formula to set up AudioFinder to work with Ableton Live.

1.    Launch a project in Ableton Live (assuming you have one already)
2.    Launch AudioFinder and using the Browser Tab navigate to the directory where the 
Ableton Live project is located.
3.    Go to the Go menu in AudioFinder and select "Make Favorites", this will link your 
found sounds to your Ableton Live project.
4.    Find sounds using AudioFinder and click Copy, this will place your found sounds in 
your Ableton Live project directory.    It is helpful to set the preference Use Without 
Creating "AudioFinder Favorites" in Folder this way the files go directly into the project 
sound file directory.
5.    When you have enough sounds go back to Ableton Live and start adding them to 
your project.

What AudioFinder Doesn't Do
AudioFinder is not an mp3 player or an Internet media player.    You have the best mp3 
player in the world already it is called iTunes, use that for mp3s.    While anyone can use
AudioFinder for any purpose, it is intended to be a tool for musicians.    Not a 
generalized media playback tool.    It is highly tuned for specific needs when working 
with programs like "Ableton Live" and "Reason."

AudioFinder does not work with mp3 files.    On a professional level don't use mp3 files 
in your music projects anyway, use PCM samples.    

AudioFinder does not use sound file format specific loop points.    

AudioFinder is intended for use with samples.



User's Mailing List
Yes, there is an AudioFinder user's mailing list.      
http://groups.yahoo.com/group/AudioFinder-users

FAQ
Q: I have a directory with several sound files and AudioFinder does not show them.
A: AudioFinder attempts to filter out non-audio files, in the case that it skips over valid
sound files you can turn "Show all files" on in the Preferences.

Q: AudioFinder does not show me the details or bpm information on mp3 file.
A: AudioFinder is intended for PCM based sampled, these formats are AIFF, SD2 and
WAVE.

Q: When I start AudioFinder the directories look different than Mac OS X Finder.
A: This is normal and in reality that is how the operating systems actually views the 
disk. 

Q: I added a bunch of new sounds to my computer and AudioFinder doesn't see them
in the Seeker
A: Check and see if they have a file extension, if not the selected "Seeker Uses 
Slower Maximum Scan."    If this is not the case, check and see if you are using the 
Seeker's saved scan long term memory, if so you will need to rescan for the new 
sounds.

Credits
AudioFinder was written by richard@mysticalsun.com
Beta Testing and Ideas Mic Berends.
Thanks to Kim Cascone for help with the BPM formula.
Encouragement and input from Len Sasso.
Lance Linimon comprehensive testing.

Price and Feature Disabling
This program was released to the world on good faith.    Faith that if you make a cool 
song and found the perfect sounds for it using AudioFinder, you would be so happy that 
you would want to help us by supporting our projects.    How much is your time worth?    
How much are time are you saving by using AudioFinder?    AudioFinder is worth the 
investment.    



Be warned AudioFinder will begin to limit features after a while if not Authorized.    The 
Seeker Tab will stop working after using AudioFinder 30 times, the rest of the application
will still function though.

AudioFinder is shareware and is offered for    the price of $35.    If you find this program 
useful please purchase it.    It may be purchased online by selecting "Purchase" under 
the "AudioFinder" menu.    When your payment is received a Response Code will be 
sent to you via email.

If the public would like new features to be made available then sending in the shareware
fee will insure it will happen.    

Authorizing
AudioFinder uses and challenge and Response Code system for authorization.    After 
purchasing AudioFinder you must email software@mysticalsun.com with your 
Challenge Code.    To find your Challenge Code go to the AudioFinder menu and select 
"Authorize..."    and click "Request Code", this will launch your default email program 
with a message prefilled with the Challenge Code.    If this does not work click "Copy 
Code to Clipboard" and launch your email program and send a message with the code 
in the subject line to software@mysticalsun.com.    You will receive a Response Code 
via email within 24 hours.    You will still be able to use AudioFinder while waiting for your
Response Code.

Upon receiving your code return to the AudioFinder menu and select "Authorize..." and 
enter your Response Code this will authorize you as a legitimate user.    Each computer 
needs it's own unique Response Code.    You are allowed to use AudioFinder on up to 3 
computers.

License Agreement
Shareware: 

Software distributed under shareware license is Copyright 2003, Mystical Sun Software.

Evaluation Registration 

This is not free software. You are hereby licensed to use this software for evaluation 
purposes without charge.

Distribution 

You are hereby licensed to make as many copies of the Shareware version of this 



software and documentation as you wish, give exact copies of the original Shareware 
version to anyone, and distribute the Shareware version of the software and 
documentation in its unmodified form via electronic    means. There is no charge for any 
of the above. 

You are specifically prohibited from charging for any such copies, however made.

License Agreement 

You should carefully read the following terms and conditions before using this software. 
Use of this software indicates your acceptance of this license agreement and warranty. 

Limitation of Liability 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND    
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY 
OTHER WARRANTIES    WHETHER EXPRESSED OR IMPLIED. NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. 

Good data processing procedure dictates that any program is thoroughly tested before 
relying on it. The user must assume the entire risk of using    the program. ANY 
LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO    PRODUCT 
REPLACEMENT OR REFUND OF PURCHASE PRICE. 


